Chapter 1

Introduction

Introduction to Nik Software Color Efex Pro™ 3.0 and the User Guide
**Introduction**

Welcome to Nik Software Color Efex Pro™ 3.0, the most advanced set of filters for digital photography.

Digital photographers have come to appreciate and take advantage of unprecedented levels of control over their images. They enjoy more options than ever to enhance, stylize, and otherwise improve upon photographs. All of this additional control, however, has led photographers to increasingly complicated choices of adjustments, filters and blends, and away from the art of control.

Color Efex Pro 3.0 filters are designed to make photographic enhancements not only easier, but better. Based on continuous feedback from professionals in Nik Software’s photographer community, Color Efex Pro 3.0 is a suite of proven controls to help photographers save time, get professional results and de-complicate the art of enhancing their images.

**Versions**


**What’s in the User Guide**

In addition to providing installation instructions, the User Guide shows you how to choose, control, and selectively apply filters, both with U Point-powered Control Points and the updated Selective Tool. The User Guide also points out differences between Color Efex Pro 3.0 and Color Efex Pro 2.0.

The typographical conventions used in this manual are:

- Color Efex Pro 3.0 processes and user interface components appear in Initial Caps, with first instances in **Bold Caps**. (In context-appropriate cases, later instances also appear in **Bold Caps**.)

- Specific control inputs appear in **Bold Italic**. Control inputs can be menu items, buttons, or sliders. Where first instances coincide with specific control inputs, the term appears in **Bold Italic**.
Chapter 2

What’s New in 3.0

New Features and Functionality in Color Efex Pro™ 3.0
What’s New in 3.0

Color Efex Pro™ 3.0 offers many enhancements and improvements over Color Efex Pro 2.0, in four general categories:

• Interface
• U Point®-powered Control Points
• Selective Tool Interaction
• New Filters

Interface

Color Efex Pro 2.0 users will notice the extensively reworked interface in version 3.0, the result of both deep study into the look and feel that professional photographers expect in modern applications and requests from Nik Software users.

The new, completely resizable interface is a professional photographic tool: color-neutral with a medium-gray background and a strong focus on efficient workflow. Color Efex Pro 3.0 groups major controls close together for greater efficiency, letting you achieve excellent results in less time. (Please see Chapter 5: Color Efex Pro 3.0 Interface.)

U Point-powered Control Points

U Point technology lets photographers achieve exactly what they envision in an easy, fast, intuitive manner. U Point-powered Control Points in Color Efex Pro 3.0 let you easily and selectively control where each filter is applied to the images, without the use of complicated selections or masks.

Additionally, some new filters in Color Efex Pro 3.0 provide unique functionality based entirely on U Point. (Please see Control Points in Chapter 5.)

Selective Tool Interaction

Originally, the Selective Tool was used to specify when to apply a Color Efex Pro 2.0 filter selectively to an image. As the popularity of Color Efex Pro 2.0 grew, photographers discovered that the Selective Tool offered more convenient access to filters than the Filters menu.

Color Efex Pro 3.0 makes this access more convenient by giving you the choice of selectively applying the filter in the Filter Interface. This lets you launch the Color Efex Pro 3.0 interface from either the Selective Tool or the Filters menu. (Please see Interaction with Color Efex Pro 3.0 in Chapter 6.)
New Filters

Color Efex Pro 3.0 offers nine new filters to Color Efex Pro 2.0 users, along with updates to existing filters.

**Bleach Bypass** – Simulates the effect of processing color film and bypassing the bleach chemistry step. Use this filter for a high-contrast, low-saturation effect used by photographers and film makers alike.

**Cross Balance** – Simulates the look of shooting either tungsten-balanced film in daylight or daylight-balanced film under tungsten lights. Use this filter to create the cool blue or warm orange effect often used in stylizing images.

**Film Effects** – Offers the look and feel of over 30 different film types, realistically simulating color sensitivity, contrast, and grain for each film.

**Film Grain** – Adds realistic film grain to any image, with control over the size and placement throughout the image.

**Glamour Glow** – Gives portrait photographers a powerful way to stylize images with dreamy, soft effects.

**Low Key** – Simulates the look of low-key photography, characterized by uniformly dark tones and low contrast.

**High Key** – Simulates the look of high-key photography, characterized by uniformly light tones and low contrast.

**Polaroid Transfer** – Simulates the effect of using Polaroid color peel-apart films and transferring the nascent image to paper before it has fully developed. The result is a low-contrast, low-saturation version of the image, with subtle shifts to the colors throughout the image, reminiscent of this popular photographic technique.

**Tonal Contrast** – Allows powerful control over the contrast only of highlights, midtones or shadows, without affecting the rest of the image. Use this filter for highly targeted control of a particular portion of the tonal range of the image.

*(Please see Chapter 9: Filter Descriptions.)*
Chapter 3

Installation

Installing and Accessing Color Efex Pro™ 3.0
Installation

Color Efex Pro 3.0 is a plug-in for Adobe® Photoshop® and other compatible applications, Adobe Photoshop Lightroom® and Apple® Aperture™. The installer provided with Color Efex Pro 3.0 automatically attempts to locate a copy of Adobe Photoshop or Adobe Photoshop Elements, Adobe Photoshop Lightroom or Apple Aperture.

Installing Color Efex Pro 3.0 and the Selective Tool

Before you install Color Efex Pro 3.0, please close all applications including Adobe Photoshop, Adobe Photoshop Lightroom, Apple Aperture, or other image editing applications that will serve as host for Color Efex Pro 3.0. Please do not open any other applications during the installation process.

To begin installation:

Double-click on the installation file provided either on your Color Efex Pro 3.0 CD or downloaded from the Nik Software web site. A window appears displaying the Color Efex Pro 3.0 Setup Wizard.

After you have read the Read Me file and accepted the End User License Agreement, the installer prompts you for the plug-in location of your image editing application.

The installer attempts to locate the most recent installation of Adobe Photoshop or Adobe Photoshop Elements, and if successful, displays the recommended folder. When installing into Adobe Photoshop Lightroom or Apple Aperture, the installer will automatically install into the appropriate location.

For Adobe Photoshop or Adobe Photoshop Elements, this location is the Plug-Ins folder located under the application’s main folder. For example:

Adobe Photoshop

Windows – C:\Program Files\Adobe\Adobe Photoshop\Plug-Ins

Macintosh – Macintosh HD : Applications : Adobe Photoshop : Plug-Ins
Chapter 3 : Installation

Adobe Photoshop Elements
Windows – C:\Program Files\Adobe\Adobe Photoshop Elements\Plug-Ins
Macintosh – Macintosh HD : Applications : Adobe Photoshop Elements : Plug-Ins

Click Browse... to open the Browse for Folder window, then navigate to the appropriate folder.

Note: For guidance on the location of Plug-Ins in applications other than Adobe Photoshop or Adobe Photoshop Elements, please refer to your application’s user manual.

After selecting the appropriate folder location, click Install. When the installation is complete, the final page of the installer appears.

If you want Color Efex Pro 3.0 to be automatically added to Lightroom’s list of External Editors, leave the Add as External Editor for Lightroom box checked. The Add as External Editor for Lightroom option will only appear if Lightroom is detected during installation. Instructions are provided within this chapter to manually add Color Efex Pro 3.0 as an external editor for Lightroom. (Please see Adding Color Efex Pro 3.0 to Lightroom as an External Editor.)

If you want the Selective Tool to open each time Adobe Photoshop or Adobe Photoshop Elements launches, leave the Open the Nik Selective Tool automatically box checked. The Selective Tool lets you apply Color Efex Pro 3.0 effects by automating the layer systems in Adobe Photoshop or Adobe Photoshop Elements. (Please see Chapter 6: Selective Tool.)

Uncheck this box to prevent the Selective Tool from opening each time Adobe Photoshop or Adobe Photoshop Elements launches. You can change this option within the Selective Tool settings interface. (Please see Chapter 8: Selective Tool Settings.)

Note: The Selective Tool is available only with Adobe Photoshop & Adobe Photoshop Elements serving as host for Color Efex Pro 3.0.

Accessing Color Efex Pro 3.0 and the Selective Tool in Adobe Photoshop

After completing the installation, launch your image editing application. In Adobe Photoshop and Adobe Photoshop Elements, Color Efex Pro 3.0 is accessed from the Filter menu.

To begin using Color Efex Pro 3.0:

1. Open the image that you would like to enhance.
2. Click the Filter menu.
3. Roll over the Nik Software sub-menu. A popup menu appears.
4. Select Color Efex Pro 3.0 from the popup menu.

The Color Efex Pro 3.0 interface appears, displaying the image specified in step 1 above. All available filters are in a single menu item, Color Efex Pro 3.0. To apply a filter to the image, either navigate to it using the built-in Filter List, or select the filter directly from the Selective Tool. (Please see Chapter 5: Color Efex Pro 3.0 Interface and Chapter 6: Selective Tool.)
You can access the Selective Tool by navigating to one of the following locations:

**Adobe Photoshop**
File > Automate

**Adobe Photoshop Elements**
File > Automation Tools

### Accessing Color Efex Pro 3.0 in Apple Aperture

In Apple Aperture, Color Efex Pro 3.0 is accessed from the Images menu. To begin using Color Efex Pro 3.0 in Apple Aperture:

1. Highlight the image(s) that you wish to enhance with Color Efex Pro 3.0. Hold the Shift key to select a sequence of images or the Command key to select individual images.
2. Click the Images menu.
3. Roll over the Edit With sub-menu. A popup menu appears.
4. Select Color Efex Pro 3.0… from the popup.

The Color Efex Pro 3.0 interface appears, displaying the image(s) specified in step 1 above.

### Adding Color Efex Pro 3.0 to Lightroom as an External Editor

If Lightroom is found during the installation of Color Efex Pro 3.0 for Lightroom, Color Efex Pro 3.0 can automatically be added as an external editor. Color Efex Pro 3.0 can also be manually added as an external editor providing easy access to edit your photos in Color Efex Pro 3.0. Follow the steps below to manually add Color Efex Pro 3.0 as an external editor.

1. Open the Preferences in Lightroom.
2. Click the External Editing tab.
3. In the Additional External Editor section select a desired File Format, Color Space, Bit Depth, Resolution, and Compression.

**Note:** Color Efex Pro 3.0 is only compatible with TIFF files (8 or 16-bit, with no compression or LZW compression).

4. Click on Choose to select an application. Navigate to the location of Color Efex Pro 3.0.
   - On Windows, the default installation location for Color Efex Pro 3.0 will be: C:\Program Files\Nik Software\Color Efex Pro 3.0 for Lightroom
   - On Macintosh, the default installation location for Color Efex Pro 3.0 will be: Macintosh HD : Applications : Nik Software : Color Efex Pro 3.0 for Lightroom
5. Select the **Color Efex Pro 3.0** file and click **Choose**.
6. Under the Preset drop-down menu, select **Save Current Settings as New Preset...** and name the preset.

Color Efex Pro 3.0 can then be easily accessed under the Photo menu as a preset external editor.
Accessing Color Efex Pro 3.0 in Lightroom

Once Color Efex Pro 3.0 is added to Lightroom as an external editor, Color Efex Pro 3.0 is accessed from the Photo menu.

To begin using Color Efex Pro 3.0 in Lightroom:

1. Highlight the image(s) that you wish to enhance with Color Efex Pro 3.0.
2. Click the Photo menu.
3. Roll over the Edit In sub-menu. A popup menu appears.
4. Select Color Efex Pro 3.0 from the popup.
5. After selecting Color Efex Pro 3.0, select whether to Edit Original, Edit a Copy, or Edit Copy with Lightroom Adjustments.

Note: If Edit a Copy with Lightroom Adjustments is selected, the Copy File Options must be determined as well. Select the File Format, Color Space, Bit Depth, Resolution and Compression for the new file to be edited in Color Efex Pro 3.0*.

*Color Efex Pro 3.0 is only compatible with TIFF and JPEG files (8 or 16-bit with no compression or LZW compression).

6. Click Edit and the Color Efex Pro 3.0 interface appears, displaying the image(s) specified in Step 1 above.

The Color Efex Pro 3.0 interface appears, displaying the image(s) specified in step 1 above.
Chapter 4

Workflow

Workflow and Tips for Enhancing Images
Workflow

The order of steps involved in enhancing an image varies, depending on the image. In general, there are only a few guidelines to consider:

- Apply noise reduction, such as with Nik Software Dfine® 2.0, as early as possible in the process.
- Apply RAW Presharpening, if desired, with Nik Software Sharpener Pro 3.0’s RAW Presharpener filter.
- Apply light and color enhancements with Nik Software Viveza™ (global, then local), and end with enhancements using Nik Software Color Efex Pro™ 3.0 or Nik Software Silver Efex Pro™.
- Apply output and creative sharpening with Nik Software Sharpener Pro 3.0’s Output Sharpener filter.
Color Efex Pro 3.0 Workflow

Start with characteristics that affect the entire image, such as color casts, contrast and tones. Next, modify elements that affect only localized areas, such as blemishes and small distracting objects. Finally, apply effects that add a style or mood to the image. In other words, move from the general to the specific.

For best results in Color Efex Pro 3.0™, perform the tasks below in the given order:

1. Select the filter to apply to the image from the Filter List provided in the interface.
2. Adjust the filter controls.
3. Protect shadows and highlights, if necessary.
4. Use U Point®-powered Control Points, if desired.
5. Review the image in the Loupe.
6. Apply the filter.
Using Color Efex Pro 3.0 as a Smart Filter (Adobe Photoshop Only)

When working within Adobe Photoshop CS3 and CS4, Color Efex Pro 3.0 can be applied as a Smart Filter. Smart Filters enable you to adjust the filter’s settings even after the filter interface has been closed. If saving the file as a PSD or layered TIFF, you can adjust the filter settings after the image and Photoshop have been closed, enabling a non-destructive workflow.

When working as a Smart Filter, the Brush button is disabled, and the filter will be applied to the active layer (even if the After Clicking OK setting is set to the Separate Layer option).

To use Color Efex Pro 3.0 as a Smart Filter:

1. Select the layer in the Layers Palette to apply Color Efex Pro 3.0 to.
2. Click the Filter menu.
3. Select Convert for Smart Filters.
4. Select the Filter menu again.
5. Rollover the Nik Software submenu. A pop-up menu appears.

Color Efex Pro 3.0 can be applied to multiple images when working in Lightroom or Aperture.

Multiple Image Controls (Lightroom)

To apply Color Efex Pro 3.0 to multiple images when working in Lightroom, follow the steps below:

1. Highlight the images you wish to enhance. Hold the Shift key to select a sequence of images or the Control/Command key to select individual images.
2. Click on the Photo menu.
3. Roll over the Edit In sub-menu option. A popup will appear.
4. Select Color Efex Pro 3.0 from the popup.

Multiple Image Controls (Aperture)

To apply Color Efex Pro to multiple images when working in Aperture, follow the steps below:

1. Highlight the images you wish to enhance. Hold the Shift key to select a sequence of images or the Command key to select individual images.
2. Click on the Images menu.
4. Select Color Efex Pro 3.0... from the popup.

When using Color Efex Pro 3.0 with multiple images, three new image controls are available. The new image controls available are Previous, Next and Save All. (Please see Filter Controls in the Filter Interface chapter for more information.)
Chapter 5

Color Efex Pro 3.0 Interface

Overview of the New Color Efex Pro™ 3.0 Interface
Filter Display Modes

Image Only

Only the Image Preview and current filter controls are displayed.

**IMAGE ONLY SHORTCUT**

Alt (Windows) / Option (Macintosh) + 1

Image and Filter List

A palette opens next to the Image Preview area and displays the names of the available filters. Also displayed are tabs for each filter category.

- Scroll down the column to preview the effect of each filter.
- Click on a tab to explore new filters.
- Click on the name of a filter to update the image in the Image Preview and the filter control sliders and settings.
- Click the star next to the name of a filter to add the filter to your Favorites tab for easy access.

**FILTER LIST SHORTCUT**

Alt (Windows) / Option (Macintosh) + 2

While working in Image and Filter List mode, you will see Filter Category Tabs.
Filter Category Tabs

The filters in Color Efex Pro 3.0 are organized by category for easy experimentation, with each category corresponding to a tab in the Filter List. Filter Category Tabs organize dozens of filters and variations into a manageable workspace.

The Favorites tab is user-definable, containing only filters you add. All other tabs are pre-defined. Six tabs will be displayed, with the All and Favorites tabs always present. The remaining four tabs can be selected from within the Filter Settings. The available tabs are:

- **All Tab** - All available filters, in alphabetical order
- **Stylizing Tab** - Filters that create a photographic style or an abstract transformation
- **Traditional Tab** - Filters that enhance an image like a conventional photographic filter or that mimic a conventional photographic process
- **Landscape Tab** - Filters that enhance or add a style to landscape and travel photography
- **Portrait Tab** - Filters most useful for images of people, in both studio and environmental portraiture
- **Wedding Tab** - Filters often used by wedding photographers
- **Nature Tab** - Filters often used by nature, wildlife, and macro photographers
- **Artistic Tab** - Abstract and stylistic filters to create different moods

- **Favorites Tab** - Filters you add using the Filter List or the Selective Tool. To add to your Favorites tab, you must be in the tab containing the desired filter. You can then add a favorite by one of the following methods (a maximum of 16 filters can be added to the Favorites tab):
  - Click the star next to the name of the desired filter while in one of the other tabs, or
  - Right- or control-click the name of the desired filter within the Selective Tool.

To remove a filter from the Favorites tab, click the star next to the name of the filter name.

Preview Modes

Color Efex Pro 3.0 offers three modes for previewing filter effects on the active image:

**Single Image Preview**

The image is displayed with the filter’s effect applied across the Image Preview area. To see the effect before and after, toggle Preview on and off with the Preview checkbox.

**Split Preview**

The image is displayed with a red line running either vertically or horizontally through it. The portion to the left or above the red line shows the image prior to applying the filter; the
portion to the right or below the red line shows the image after the filter has been applied.

You can move the image with the Pan Tool or click and drag the red line to observe the effect on the image’s detail.

Click the Rotate Preview button to alternate between vertical and horizontal split.

Side-by-side Preview

Two separate previews appear. The portion on the left or on top shows the image prior to applying the filter; the portion on the right or at bottom shows the image after the filter has been applied.

The previews are linked for zooming and panning. This lets you see the before- and after-images as a whole, or at the fine-detail level.

Click the Rotate Preview button to alternate between vertical and horizontal layout.

Preview

Preview lets you toggle on and off a preview of the filter effects applied to the active image.

- Click the Preview checkbox to alternate between displaying and hiding the effects.

Preview Modes

Filters in Color Efex Pro 3.0™ affect images in two ways: globally and selectively.

To help you find the results of selective filters, Color Efex Pro 3.0 includes two Preview Modes: Effect Overlay and Effect Mask.

Original Image

In this default mode, the image appears in color.

Effect Overlay

The original image appears with an overlay showing where the filter’s effect is applied, according to the Control Points added to the image. You can adjust the filter controls or Control Points while in the Effect Overlay mode.

A red overlay indicates those areas enhanced by the filter; no visible overlay (i.e., the original colors of the image) indicates unaffected areas.
Effect Mask

This mode displays the mask created automatically by the filter and the Control Points added to the image. You can adjust the filter controls or Control Points while in the Effect Mask mode.

White indicates those areas enhanced by the filter, black indicates unaffected areas, and gray indicates moderately affected areas.

Select Tool

The Select Tool lets you select and interact with Control Points.

SELECT SHORTCUTS

Press the A key to switch to this tool.

Ctrl (Windows) / Command (Mac) to temporarily switch to this tool

Zoom Tool

The Zoom Tool lets you zoom in and out of the active image. Select this tool, then click on the area of the image that you want to magnify. To zoom out, press and hold the Alt (Windows) or Option (Macintosh) key and click on the image.

Color Efex Pro 3.0 offers three zoom states:

- **Zoom to Fit** to see the entire image within the Image Preview and automatically adjust the zoom factor as you change the size of the interface.
- **100%** to show the actual pixel details.
- **300%** to zoom even further into the image and view fine pixel detail.

ZOOM SHORTCUTS

Press the Z key to switch to this tool.

Ctrl (Windows) / Command (Macintosh) + Spacebar to temporarily switch to this tool

Ctrl (Windows) / Command (Macintosh) + ‘+’ to zoom in one level

Ctrl (Windows) / Command (Macintosh) + ‘-’ to zoom out one level

Ctrl (Windows) / Command (Macintosh) + 0 to Zoom to Fit

Ctrl (Windows) / Command (Macintosh) + Alt (Windows) / Option (Macintosh) + 0 to zoom to 100%

Pan Tool

The Pan Tool lets you reposition the image while zoomed into the 100% or 300% views. When the Loupe tool is enabled, the mouse pointer becomes a Pan Tool to let you reposition the content of the Loupe tool.

PAN SHORTCUTS

Press the H key to switch to this tool.

Spacebar to temporarily switch to this tool
Background Color Selector

The Background Color Selector tool lets you change the color of the background surrounding the image. The three choices are Light Gray, Medium Gray, and Dark Gray.

Image Preview

The Image Preview area displays the active image and related information beneath the image.

Image

The active image is displayed with the view, preview mode, background and zoom state you have configured. This area has three zoom states: Zoom to Fit, 100%, and 300%, controlled with the Zoom Tool or with keyboard shortcuts. (Please see Zoom Tool above.)

Image Info

The filename appears below the image. This is visible in the Zoom to Fit state. If Exif data is available, additional image information will be displayed under the filename.

Filter Controls

Color Efex Pro 3.0 integrates all available filters into a single filter interface. Using either the Filter List or the Filter Previous/Filter Next buttons, you can change filters quickly and easily, and the filter control sliders change to match the settings of the filter (and some filter variants) selected. (For a complete explanation, please see Chapter 9: Filter Descriptions)

- Click on the Filter Previous button to cycle to the previous filter in alphabetical order.
- Click on the Filter Next button to cycle to the next filter in alphabetical order.

Shadows & Highlights

The Protect Shadows and Protect Highlights sliders help you protect image details at both ends of the tonal range. The controls take advantage of the TrueLight™ function in Color Efex Pro 3.0 and modify the filter's effect to preserve image details. (These controls appeared on the Advanced tab in Color Efex Pro 2.0.)

When collapsed, this section displays one slider for protecting shadows and one for protecting highlights. As you click and drag either slider to the right or left to increase or decrease protection, notice the change in the details in the image.
When expanded, this section displays not only the sliders, but also a histogram representing the full tonal range of the active image after the current enhancement has been applied. The histogram changes in real time as you adjust the filter controls and Protect Shadows/Protect Highlights sliders.

The colored areas at both ends of the histogram help identify potential problems. The top and bottom 2.5% of tonal values (representing Shadows without Detail on the left and Highlights without Detail on the right) appear in red. The next 2.5% of the shadows and highlights (indicating Shadows with Detail on the left and Highlights with Detail on the right) appear in green.

Connected to each of the four colored areas (Shadows without Detail, Shadows with Detail, Highlights without Detail, Highlights with Detail) are numerical call-outs displaying the percentage of pixels from the active image in each of those four areas after the enhancement has been applied.

The Protect Shadows and Protect Highlights sliders helps you keep your image details from falling into these areas. For best results, keep the greater part of the image between the green areas (Shadows with Detail and Highlights with Detail) of the histogram. Portions of the image in Shadows without Detail will likely print pure black; those in Highlights without Detail will likely print as paper white.

- Click and drag the Protect Shadows slider to the right to adjust the filter’s effect and prevent details from being moved into the Shadows without Detail area.

- Click and drag the Protect Highlights slider to the right to adjust the filter’s effect and prevent details from being “blown out” or being moved into the Highlights without Detail area.

**Note:** In general, it is best to maintain the histogram in the region between Shadows with Details and Highlights with Details sections. Nevertheless, many good images have values in those areas of the histogram (e.g., highlight on a chrome bumper).

### Control Points

When collapsed, this section provides access to the Add 0% Control Point and Add 100% Control Point buttons, enabling you to use U Point-powered Control Points to specify where an image’s effect is applied within the image, without using masks and selections.

When expanded, this section provides you with a list of the Control Points added to the image, as well as controls for those Control Points.

U Point technology lets photographers identify and isolate objects within a photograph by placing a Control Point on the object or area to be affected. By analyzing color, tonality, detail and location, U Point determines where to apply certain effects, according to the photographer’s needs. *(For more information on U Point technology, please visit www.upoint.com.)*

All Control Points within the active image communicate with each other, providing continuity of control over multiple objects throughout the image.
Each Control Point in Color Efex Pro 3.0 can control the extent to which the selected object is affected by a filter. This lets you add Control Points and then decide whether and how strongly to apply the filter to each object.

Each Control Point has two sliders:

- The top slider, Size, controls the size or reach of the Control Point. Click and drag this control rightward to enlarge the Control Point's reach, or leftward to reduce its reach, as indicated by an expanding or contracting circle.

- The bottom slider, Opacity, controls the extent to which the effect is added to the image. At 100%, the filter's full effect is applied to the selected object; at 0%, the selected object retains its original colors and details.

The following controls apply to all filters:

**Add 0% Control Point**

Click this button to add a Control Point preset to no filter effect (i.e., 0% opacity). The mouse pointer changes, indicating that you can place a Control Point on the image. After placing the Control Point on the image, you can adjust the Opacity slider.

**Add 100% Control Point**

Click this button to add a Control Point preset to the full effect of the filter (i.e., 100% opacity). The mouse pointer changes, indicating that you can place a Control Point on the image. After placing the Control Point on the image, you may adjust the filter's effect with the Opacity slider.

If the first Control Point added is a 100% Control Point, the **Apply to entire image** slider will automatically move to 0% to ensure that the filter effect is applied only at that Control Point. You can then adjust the slider manually.

**Delete**

To remove a Control Point, click the Select tool, then click on the Control Point to be removed. Then either click the Delete button or press the Delete key on your keyboard.

**Apply to entire image**

This slider lets you specify how much of the current effect to apply across the entire image. Click the 0% or 100% shortcut buttons to move the slider immediately to 0% or 100%, or click and drag the slider to the desired value.

Any Control Points added to the image override the effect of this slider for the object they select. For example, if you specify a filter effect on an entire landscape photograph, set **Apply to entire image** to 100%, and then later add a Control Point to the sky at 0% opacity, the filter will have no effect on the sky.

**Control Point Details**

This area shows you the details for each of the Control Points currently added to the image.

Click on a Control Point listed in this section to select it in the image, and click on the percentage displayed to type in a new value manually.
**Reset**

Click the **Reset** button to remove all Control Points from the image and set the **Apply to entire image** slider to 100%.

To adjust or delete multiple Control Points or adjust their controls in parallel, first select the desired Control Points by one of the following methods:

- Click the **Select** Tool, then left-click, hold and draw a bounding box containing the desired Control Points, or
- Hold the **Shift** key down and click on the Control Points to be selected.

With multiple Control Points selected, you can delete all or modify the filter controls of all Control Points at the same time by adjusting those of only one.

After adding Control Points to the image and applying different levels of opacity to each object, you can look at the **Effect Overlay** or **Effect Mask** to see how the filter is affecting the image. (Please see Effect Overlay and Effect Mask above.)

**Note:** **Control Points are not saved in a settings file.**

**Quick Save Slots**

**Quick Save Slots** (called **Single-Click Presets** in Color Efex Pro 2.0) let you save and access frequently used settings.

- Click **Set** to save your settings for the current filter and optionally rename the Quick Save Slot.
- Click on the desired Quick Save Slot to apply the saved settings.
- Click **Default** to use the default settings for that filter.

**Note:** **Quick Save Slots store settings for filter controls and Shadow & Highlights. Control Points added to the image are not saved in Quick Save Slots.**

**Navigator Loupe**

The **Navigator Loupe** is one of the new interface features in Color Efex Pro 3.0. This tool ensures that the appropriate information is displayed depending on the state of the Image Preview. In the Zoom to Fit view, the Loupe mode displays details under the mouse pointer at 100%, and image detail information before and after the filter is applied. When zoomed to 100% or 300%, the Navigator mode is displayed, giving you a bird’s eye view of where you are currently in the image. The view switches automatically between Navigator and Loupe for efficient workflow.

**Loupe Mode**

With the Image Preview in the Zoom to Fit state, the **Navigator** switches to Loupe mode. A vertical red line bisects the image, the left-hand section displaying the image prior to applying the filter and the right-hand side, the image after filter application. This ensures that you can always see the image detail
at 100% while reviewing the filter’s effect where you position your mouse in the Preview.

To lock in place the area displayed in the Loupe, click the *pushpin* icon in the lower-left corner of the Loupe, then click on the area of the image you want to keep inside the Loupe. To unlock the area, click the *pushpin* icon again. Alternately, right-click (Windows) or Control-click (Macintosh) to toggle the *lock in place* function.

To pan within the Loupe display, click and drag the image. You can also click and drag the red line to adjust the relative size of the before and after sections in the Loupe.

** Navigator Mode

When you switch the Zoom to Fit state to 100% or 300%, the Navigator Loupe switches to the Navigator mode and a red rectangle indicates the area of the image currently displayed in the Image Preview. Click on the area of the image in the Navigator that you would like to display in the Image Preview.

** Filter controls

Use the filter controls to apply or discard filter effects.

The *Brush* and *OK* buttons process and apply the specified filter’s effect to the active image. The *Cancel* button discards any settings specified in the current session, and closes Color Efex Pro 3.0 without changing the image.

** Brush (Adobe Photoshop Only)

Click *Brush* to apply the filter’s effect to a separate layer and then selectively paint the effect in, using the Selective Tool to automatically create and modify a layer mask. *(Please see Chapter 6: Selective Tool.)*

** Cancel

Click *Cancel* to prevent any effect from being applied to the image, close the current Color Efex Pro 3.0 session, and return to your image editing application.

** CANCEL SHORTCUT

Press the *Esc* key to cancel.

** OK (Adobe Photoshop) / Save (Lightroom and Aperture)

Click *OK/Save* to apply the specified filter to the image(s), close the current Color Efex Pro 3.0 session, and return to your image editing application. Color Efex Pro 3.0 also gives you the option of applying the filter to a separate layer or to the current layer in Adobe Photoshop or Photoshop Elements. *(Please see Chapter 7: Filter Interface Settings.)*

** OK/SAVE SHORTCUT

Press *Enter* (Windows) / *Return* (Macintosh) key to apply the filter.
Multiple Image Controls (Lightroom and Aperture)

When using Color Efex Pro 3.0 with multiple images, three new image controls are available. The new image controls available are Previous, Next, and Save All.

Previous

The Previous button will go to the image previously enhanced within the current Color Efex Pro 3.0 session.

Next

The Next button will proceed to the next selected image in the current Color Efex Pro 3.0 session.

Save All

Click Save All to apply Color Efex Pro 3.0 to the open images and close the current Color Efex Pro 3.0 session.

SAVE ALL SHORTCUT:

Press the Enter (Windows) / Return (Macintosh) key to apply Color Efex Pro 3.0 to the selected images in the current Color Efex Pro 3.0 session.
Chapter 6
Selective Tool
Applying the Filter’s Effect Selectively
Selective Tool

The Selective Tool automates the creation of layers and layer masks within Adobe Photoshop and Adobe Photoshop Elements, letting you apply any available Color Efex Pro 3.0 filters.

If Dfine® 2.0 is already installed, the Selective Tool installed by Color Efex Pro™ 3.0 will simply update the one installed by Dfine 2.0, letting you access both products from the same palette.

The Selective Tool can be used with pressure-sensitive tablets such as the Wacom® Pen Tablet to apply the Color Efex Pro 3.0 filter with pressure-sensitivity.

Note: The Selective Tool is available only with Adobe Photoshop and Adobe Photoshop Elements serving as host for Color Efex Pro 3.0.

Note: The Selective Tool cannot be used when creating a Photoshop Action. In order to create a Photoshop Action, please select Color Efex Pro 3.0 from the Filters menu.

Interaction with Color Efex Pro 3.0

Click the filter name in the Color Efex Pro 3.0 section of the Selective Tool window to launch that filter.

If you click the Brush button in the Color Efex Pro 3.0 filter interface, whether you launched that filter from the Selective Tool or from Photoshop or Photoshop Elements’ Filters menu, the Selective Tool appears. The filter will be applied to a copy of the image on a separate layer, the new layer will be named after the filter you are using, and you can selectively apply the filter’s effect using the Paint, Erase, Fill, and Clear buttons described later in this chapter.

Filter Selection Tabs

Choose one of the Filter Selection Tabs to display the filters available within each tab.

Favorites Tab

To add to your Favorites tab, you must be in the tab containing the desired filter. Then:

• Right- or control-click the name of the desired filter within the Selective Tool.

A maximum of 16 filters can be added to the Favorites tab. The Favorites tab of the Selective tool mirrors the Favorites tab of the Filter List.
Selection Tools

The **Selective Tool** contains four tools for applying the selected Color Efex Pro 3.0 filter.

**Paint**

Click the **Paint** button to selectively paint the current filter's effect into the active image. Ensure that your Paint Brush mode is set to Normal and that Opacity is set to 100%. You can control the degree to which the effect is added to the image by varying the opacity of the brush.

**Erase**

Click the **Erase** button to selectively remove the current filter's effect from the active image. Ensure that your Paint Brush mode is set to Normal and that Opacity is set to 100%. You can control the degree to which the effect is removed from the image by varying the opacity of the brush.

**Fill**

Click the **Fill** button to apply the filter’s effect to the entire image. This tool is especially useful if you want to apply the filter’s effect to all but a small area. Click **Fill**, then click **Erase** to remove the effect from the area to remain unaffected.

**Clear**

Click the **Clear** button to remove the filter’s effect from the entire image. This is helpful if you made a mistake with the Paint tool and want to start over.

Apply / Discard

Click **Apply** to apply the current filter’s effect to the image. Click **Discard** to prevent the effect from being applied.
Chapter 7

Filter Interface Settings

Controlling the Default Behavior of the Filter Interface
Filter Interface Settings

Click on **Settings** in the Color Efex Pro™ 3.0 Filter Interface to configure default look and functionality, and to specify how Color Efex Pro 3.0 affects images. You are presented with two tabs, Filter Settings, and Filter List.

**Filter Settings**

The following settings are available within the Filter Settings tab:

- **Default Zoom**
  - **Default Zoom** lets you specify the zoom state to be applied when the interface is launched. (Please see Zoom Tool.)
  - **100%**
    - Opens images at 100% zoom.
  - **Zoom to Fit**
    - Ensures that the entire image is visible within the filter interface.

- **Default Preview**
  - **Default Preview** lets you specify how images are displayed upon opening Color Efex Pro 3.0. (Please see Preview Modes in Chapter 5.)
  - **Single Image Preview**
    - Sets Single Image View as default.
  - **Split Preview**
    - Sets Split preview as default.
  - **Side-by-side Preview**
    - Sets Side-by-side preview as default.
  - **Use Last Setting**
    - Opens images in the last preview state used in the previous Color Efex Pro 3.0 session.

- **Default Appearance**
  - **Default Appearance** sets the brightness of the area surrounding the image in the Preview.
    - Light Gray
    - Medium Gray
    - Dark Gray

- **Use Last Setting**
  - Opens images in the last zoom state used in the previous Color Efex Pro 3.0 session.
Chapter 7: Filter Interface Settings

After Clicking OK (Adobe Photoshop Only)

This option lets you specify how Color Efex Pro 3.0 filters are applied.

**Note:** This option is valid only with Adobe Photoshop and Adobe Photoshop Elements serving as host for Color Efex Pro 3.0.

Apply the Filtered Effect to the Current Layer

This option applies the effect to the layer that was active when Color Efex Pro 3.0 was launched.

Apply the Filtered Effect to a Separate Layer

Choose this option to always apply the filter effects of Color Efex Pro 3.0 to a separate layer. Use this option and save the final image in a layered format to ensure the preservation of original image details.

**Note:** Enabling this option increases file size and may increase processing time.

**Note:** When batch processing with Color Efex Pro 3.0, the filter effect is not applied to a separate layer. To apply Color Efex Pro 3.0 to a separate layer while recording the action, duplicate the layer prior to applying Color Efex Pro 3.0. This ensures that the batch process includes a new filtered layer for each image.

Reset

Click Reset to restore Color Efex Pro 3.0 filter settings to their default values.

The following settings are available within the Filter List tab:

Filter Category Tab 1:

The contents of the first Filter Category Tab is always the All tab, displaying all filters.

Filter Category Tab 2:

Use this option to select which set of filters to display within the second Filter Category Tab.

Filter Category Tab 3:

Use this option to select which set of filters to display within the third Filter Category Tab.

Filter Category Tab 4:

Use this option to select which set of filters to display within the fourth Filter Category Tab.

Filter Category Tab 5:

Use this option to select which set of filters to display within the fifth Filter Category Tab.

Reset

Click Reset to restore Color Efex Pro 3.0 filter tabs to their default values.
Chapter 8
Selective Tool Settings
Controlling the Default Behavior of the Selective Tool
Selective Tool Settings (Adobe Photoshop Only)

Click the Settings button at the bottom of the Selective Tool interface to specify how the Selective Tool interacts with Adobe Photoshop or Adobe Photoshop Elements and active images.

When Photoshop Launches

This option lets you specify whether the Selective Tool opens when Adobe Photoshop or Adobe Photoshop Elements is launched. Choose between:

- Automatically Open the Selective Tool
- Do Not Open the Selective Tool

Apply filter to:

Advanced users can specify how the Selective Tool applies filters in Color Efex Pro™ 3.0.

Image Composite

Select this option to create a new layer and perform a stamp-visible command into the new layer to ensure that the filter is applied to the entire image and not only to the active layer. (This is the default behavior in Color Efex Pro 3.0. This is also how the Selective Tool operates in all other Nik Software products.)

Active Layer

Select this option to duplicate the layer active when you selected the Color Efex Pro 3.0 filter, and apply the filter to that layer only.

After clicking Apply

This option lets you specify whether the Selective Tool maintains Color Efex Pro 3.0 filter effects as a separate layer or merges layers when you click Apply.

Merge the Filtered Effect to the Current Layer

This option merges the filtered image with your original image into one layer. Enabling this option helps keep file sizes to a minimum.

Apply the Filtered Effect to a Separate Layer

The Keep as Layer option ensures that the filtered effect is limited to a separate layer. By enabling this setting and saving the active image in a layered file, you preserve original image information and can remove the filter's effect at any time. Please keep in mind, however, that enabling this option may increase file sizes.
Chapter 9

Filter Descriptions
Effects and Controls for Each Filter

Understanding Complementary Colors

Some filters in Color Efex Pro 3.0 involve complementary colors, which are color opposites that reside directly across from each other on a color wheel. A color’s complement can be created by mixing the other two primary colors together. For example, red’s complementary color is cyan, which can be created by mixing green and blue together.

B/W Conversion (3 Effects)

B/W Conversion combines methods and filters from Color Efex Pro 2.0 – B/W Conversion, B/W Conversion Dynamic Contrast, and B/W Conversion Tonal Enhancer – in a single filter. Use this filter to transform a color image into a black and white version, with control over the shadows, highlights, and relationships among the original colors. Each method simulates the placement of a traditional black and white color filter in front of the lens.

Use the provided pull-down menu to select the B/W Conversion method. The following B/W Conversion methods and controls are available:

**B/W Conversion**

Creates a traditional conversion from color to black and white.

**Filter Color** – Adjusts the color of the simulated filter and controls the relationship of colors in the image. This lightens objects of that color in the image and darkens objects of the complementary color.

**Filter Strength** – Slides to the left for less contrast between colors, to the right for more contrast between colors.

**Brightness** – Controls the overall lightness of the image.

**Contrast** – Controls the overall contrast of the image.

**B/W Conversion: Tonal Enhancer**

Provides special contrast methods to increase details in the image.

**Filter Color** – Adjusts the color of the simulated filter and controls the relationship of colors in the image. This lightens objects of that color in the image and darkens objects of the complementary color.

**Filter Strength** – Slides to the left for less contrast between colors, to the right for more contrast between colors.

**Brightness** – Controls the overall lightness of the image.

**Method** – From the pull-down menu, select a contrast type.
B/W Conversion: Dynamic Contrast

Creates exaggerated contrast and stylistic black and white images.

Filter Color – Adjusts the color of the simulated filter and controls the relationship of colors in the image. This lightens objects of that color in the image and darkens objects of the complementary color.

Filter Strength – Slides to the left for less contrast between colors, to the right for more contrast between colors.

Brightness – Controls the overall lightness of the image.

Contrast Enhancer – Controls the additional contrast introduced to the image for a stylistic effect.

Bi-Color Filters (20 Effects)

Blends two colors and then adds the result to the active image.

From the pull-down menu, select a pre-defined color combination, each with four variations. Each variation provides the following controls:

Opacity – Controls the overall strength of the filter.

Blend – Controls the size of the blend between the two colors in the filter.

Vertical Shift – Controls the placement of the filter’s horizon.

Rotation – Controls the angle of the filter’s horizon.

Bi-Color User Defined

Blends two user-defined colors and then adds the result to the active image.

Upper Color – Specifies the top color to be applied to the image. Use either the supplied eyedropper to select a color from the current image or click on the color patch to access a color picker.

Lower Color – Specifies the bottom color to be applied to the image. Use either the supplied eyedropper to select a color from the current image or click on the color patch to access a color picker.

Opacity – Controls the overall strength of the filter.

Blend – Controls the size of the blend between the two colors in the filter.

Vertical Shift – Controls the placement of the filter’s horizon.

Rotation – Controls the angle of the filter’s horizon.
Bleach Bypass

Simulates the effect of processing color film and bypassing the bleach chemistry step. Use this filter for a high-contrast, low-saturation effect used by photographers and film makers alike.

**Brightness** – Controls the overall lightness of the image.

**Saturation** – Controls the overall vibrancy of colors by increasing or decreasing saturation throughout the image.

**Global Contrast** – Controls the overall contrast throughout the image.

**Local Contrast** – Creates contrast within objects, accentuating details.

Brilliance/Warmth

Adds either a cool or warm cast to the image while applying a saturation effect.

**Brilliance** – Increases or decreases saturation of the colors in the image.

**Warmth** – Controls the temperature of the colors in the image. Move the slider to the left to cool the colors (adding blues), or to the right to warm the colors (adding reds).

Burnt Sienna

Adds extreme warmth and contrast to affect the mood and style of the image.

**Brightness** – Controls the overall lightness of the image.

**Contrast** – Controls the overall contrast of the image.

Classical Soft Focus (6 Effects)

Introduces traditional photographic effects to stylize an image and soften unwanted detail. This filter simulates traditional, soft focus filters and diffusion techniques.

From the pull-down menu, select the type of blur to add to the image. Each blur type offers the following controls:

**Diffused Detail** – Controls the amount of random detail added to the soft focus effect. This can help maintain the appearance of detail and prevent banding.

**Strength** – Controls the degree to which you want to apply the filter.

**Brightness** – Controls the overall lightness of the image.
**Color Stylizer**

Overlays a color on top of the image and lets you control the saturation of the original image’s color.

**Color** – Adds a color to the image. To select a color for this control you may either use the eyedropper within the active image or click on the color patch using the color picker in your image editing application.

**Contrast** – Controls the overall contrast of the image.

**Saturation** – Controls the amount of color to include from the original image. Slides to the left to create a monochrome image, to the right to maintain the full level of color from the original image.

**Colorize (6 Effects)**

Inks the image with a color and provides different color and contrast relationships to stylize the image.

From the pull-down menu, select the relationship between the original colors in the image and the color being added. Each option provides the following controls:

- **Color** – Lets you select a color to add to the image. To select a color for this control you may either use the eyedropper within the active image or click on the color patch using the color picker in your image editing application.
- **Strength** – Controls the degree to which you want to apply the filter.

**Contrast Color Range**

Provides control over the contrast between selected colors within an image. Use this filter to isolate or blend objects with other objects, according to their color.

- **Color** – Selects the color range to which to apply contrast. This lightens objects of that color in the image and darkens objects of the complementary color.
- **Color Contrast** – Controls the contrast between the color selected and other colors in the image. Slides to the left for less contrast between colors, to the right for more contrast between colors.
- **Brightness** – Controls the overall lightness of the image.
- **Contrast** – Controls the overall contrast of the image.
Contrast Only

Increases the contrast of an image without affecting the color characteristics of the image.

**Brightness** – Controls the overall lightness of the image without affecting the color and saturation.

**Contrast** – Controls the overall contrast of the image without affecting the color and saturation.

**Saturation** – Controls the overall vibrancy of colors by increasing or decreasing saturation throughout the image.

Cross Balance (6 Effects)

Simulates the look of shooting either tungsten-balanced film in daylight or daylight-balanced film under tungsten lights. Use this filter to create the cool blue or warm orange effect often used in stylizing images.

From the provided pull-down menu, select the Cross Balance method. The Daylight to Tungsten options emulate using daylight balanced film with tungsten lights, while the Tungsten to Daylight emulate using tungsten balanced film in daylight.

**Strength** – Controls the degree of cross balance effect.

Cross Processing (19 Effects)

Simulates the effect of processing color film with the wrong chemistry; that is, processing negative film with slide chemistry (C41 to E6 cross-processing) or slide film with negative chemistry (E6 to C41 cross-processing).

From the provided pull-down menu, select the Cross Processing method. Select **C41 to E6, E6 to C41**, or variations on either style.

**Strength** – Controls the degree to which you want to apply the filter.

Darken/Lighten Center

Draws the eye toward or away from the center of the image. A lighter center and darker edges draw the eye to the center of the image, and a darker center and lighter edges draw the eye to the edges.

From the pull-down menu, specify round or oval shape for the Darken/Lighten effect. Both shapes provide the following controls:

**Center Luminosity** – Controls the brightness at the center of the image.
**Border Luminosity** – Controls the brightness at the edges of the image.

**Center Size** – Controls the relationship between the center and the edges.

**Place Center** – Positions the center of the image. This is useful if the subject is not in the center of the frame. Click this button and then place the center where desired.

**Detail Stylizer (18 Effects)**

Detail Stylization combines methods and filters from Color Efex Pro 2.0 – Pop Art, Stairs, Weird Dreams, and Weird Lines – in a single filter. Use this filter to introduce effects based on the shapes and details found in the original image.

From the pull-down menu provided, select one of the available filters. The following filters and controls are available:

**Pop Art**

Creates abstract color shapes and patterns from image details.

**Effect Transparency** – Controls the degree to which the original image remains visible with the Pop Art effect.

**Color Set** – From the pull-down menu, select a pre-defined color combination.

**Saturation** – Controls the amount of color in the shapes created by the filter.

**Brightness** – Controls the lightness of the shapes created by the filter.

**Size** – Controls the relationship between the shapes and the original details of the image.

**Stairs**

Breaks an image into its component shapes and brightens its original colors to create an abstract, stylized image of stair objects.

**Contrast** – Controls the contrast among the objects.

**Effect Size** – Controls the distance between objects.

**Saturation** – Controls the amount of color introduced to the objects.

**Weird Dreams**

Transforms the original image into its component shapes and forms and applies one of six color sets to create an abstract, colorful version of the original image.

**Color Set** – From the pull-down menu, select colors for the shapes in the image.

**Size** – Controls the relationship between the shapes created by the filter and the original image details.
Weird Lines
Adds texture to an image by introducing abstract, transparent shapes and contours that mimic the shapes in the original image.

**Style** – From the pull-down menu, select colors for the shapes in the image.

**Size** – Controls the relationship between the shapes created by the filter and the original image details.

**Contrast** – Controls the contrast among the shapes.

**Duplex**

Creates a stylistic, duotone effect with options for color, blur and saturation.

**Color** – Adds a color to the image. To select a color for this control you may either use the eyedropper within the active image or click on the color patch using the color picker in your image editing application.

**Strength** – Controls the degree to which you want to apply the filter.

**Diffusion** – Controls the amount of blur added for a stylistic effect.

**Saturation** – Controls the amount of color to include from the original image. (At 0%, this creates the effect of the Duplex: Monochrome filter from Color Efex Pro 2.0.)

**Contrast** – Controls the overall contrast of the image.

Dynamic Skin Softener

Creates soft, lustrous skin, without affecting other objects in the image. Use this filter with objects other than skin to take advantage of its unique softening algorithm.

**Skin Color** – Select the color of the skin tone using either the eyedropper within the active image or click on the color patch using the color picker in your image editing application.

**Color Reach** – Controls the range of affected colors. Slides to the left to narrow the range of affected colors to only the hue and shade selected, to the right to expand the range beyond those selected. At 100%, the Dynamic Skin Softener effect will be applied to the entire image—use Control Points to limit only to the areas that require softening.

**Small Details** – Controls the amount of softening applied to small details.

**Medium Details** – Controls the amount of softening applied to medium details.

**Large Details** – Controls the amount of softening applied to large details.
Film Effects (33 Effects)

**New in Color Efex Pro 3.0**

Offers the look and feel of over 30 different film types, realistically simulating color sensitivity, contrast, and grain for each film.

**Film Type** – From the pull-down menu, select any of the pre-defined film types.

**Film Details** – Displays the settings for the currently selected film type and lets you create a custom film type.

**Brightness** – Controls the overall lightness of the image.

**Contrast** – Controls the overall contrast of the image.

Clicking on the show/hide triangle for **Film Details** displays the following controls:

**Sensitivity**

Controls the film’s lightness response to different wavelengths of light.

**Red through Violet** – sliders control how bright or dark an object of that color appears. Slide to the left to make objects of that color darker, to the right to make them brighter.

**Saturation**

Controls the film’s saturation response to different wavelengths of light.

**Red through Violet** – sliders control how saturated an object of that color appears. Slide to the left to make objects of that color less saturated, to the right to make them more saturated.

**Tone Curve**

Controls contrast and tonal response in the film.

**Channels** – From the pull-down menu, select a channel to modify, then click to add anchor points to the curve to specify the brightness, contrast, and relationship of tonal values in the image.

**Grain**

Adds grain to the image and lets you specify the size of the grain and its placement throughout the image.

**Grain Size** – From the pull-down menu, select one of five grain sizes, from ultra-fine to extra-coarse.

**Highlight Grain** – Controls the degree of grain added to the highlights of the image.

**Midtone Grain** – Controls the degree of grain added to the midtones of the image.

**Shadow Grain** – Controls the degree of grain added to the shadows of the image.
Grain Saturation – Controls the saturation of the grain added to the image. Moving this slider to the left emulates monochromatic grain, while moving this slider to the right emulates color grain.

**Film Grain**

- **Highlight Grain** – Controls the amount of grain added to the highlights of the image.
- **Midtone Grain** – Controls the amount of grain added to the midtones of the image.
- **Shadow Grain** – Controls the amount of grain added to the shadows of the image.

Film Grain is new in Color Efex Pro 3.0 Complete Edition and Select Edition. It adds realistic film grain to any image, with control over the size and placement throughout the image.

From the pull-down menu, select one of five grain sizes, from Ultra-Fine to Extra-Coarse. Each grain size provides the following controls:

- **Highlight Grain** – Controls the amount of grain added to the highlights of the image.
- **Midtone Grain** – Controls the amount of grain added to the midtones of the image.
- **Shadow Grain** – Controls the amount of grain added to the shadows of the image.

Grain Saturation – Controls the saturation of the grain added to the image. Moving this slider to the left emulates monochromatic grain, while moving this slider to the right emulates color grain.

**Flux** (5 Effects)

Introduces subtle effects in or creates an abstraction of image details.

From the pull-down menu, select one of the effects of the Flux filter. The effects range from subtle detail shifts to strong color and contrast effects. Each option provides the following controls:

- **Strength** – Controls the degree to which you want to apply the filter.
- **Size** – Controls the degree of the effect, and the relationship among colors and details throughout the image.

**Fog**

Simulates traditional fog effect: A pronounced, soft focus giving the appearance of fog.

From the pull-down menu, select one of the methods of the Fog filter. Each method provides you with the following control:

- **Intensity** – Controls the degree to which you want to apply the filter.
**Foliage**

Identifies foliage and greenery in an image and enhances or stylizes those objects.

From the pull-down menu, select one of the effects of the Foliage filter. Each option provides the following control:

**Enhance Foliage** – Controls the degree to which you want to apply the filter.

---

**Glamour Glow**

Gives portrait photographers a powerful way to stylize images with dreamy, soft effects.

**Glow** – Controls the degree of the filter’s softening technique.

**Brightness** – Controls tonality throughout the image.

**Glow Temperature** – Controls the temperature of the effect added to the image. Moving this slider to the left creates a cool blue effect, while moving this slider to the right creates a warm red-orange effect.

---

**Graduated Filters (16 Effects)**

Blends a color into a portion of an image, with a gradual transition to the original image.

From the pull-down menu, select a pre-defined color combination, each with four variations. Each color combination provides the following controls:

**Opacity** – Controls the overall strength of the filter.

**Blend** – Controls the size of the blend between the two colors in the filter.

**Vertical Shift** – Controls the placement of the filter’s horizon.

**Rotation** – Controls the angle of the filter’s horizon.

---

**Graduated Fog**

Simulates traditional fog effect (very strong soft focus giving the appearance of fog) in one half of the image.

From the pull-down menu, select one of the styles of the Fog effect. Each style provides the following controls:
**Opacity** – Controls the overall strength of the filter.

**Blend** – Controls the size of the blend between the fog effect and the original image details.

**Vertical Shift** – Controls the placement of the filter’s horizon.

**Rotation** – Controls the angle of the filter’s horizon.

### Graduated Neutral Density

Blends a user-defined color into a portion of an image, with a gradual transition to the original image.

**Color** – Specifies the color of the graduated effect to be applied to the image. To select a color for this control you may either use the eyedropper within the active image or click on the color patch using the color picker in your image editing application.

**Opacity** – Controls the overall strength of the filter.

**Blend** – Controls the size of the blend between the two colors in the filter.

**Vertical Shift** – Controls the placement of the filter’s horizon.

**Rotation** – Controls the angle of the filter’s horizon.
High Key

New in Color Efex Pro 3.0 Complete Edition

Simulates the look of high-key photography, characterized by uniformly light tones and low contrast.

Add Glow – Controls the degree of glow around objects from the high key effect.

Saturation – Controls the overall vibrancy of colors by increasing or decreasing saturation throughout the image.

Effect Strength – Controls the degree to which you want to apply the filter.

Indian Summer

Complete Edition

Identifies foliage and greenery in an image and enhances or stylizes those objects, creating warm colors similar to seasonal fall scenery.

From the pull-down menu, select one of the effects of the Indian Summer filter. Each option provides the following control:

Enhance Foliage – Controls the degree to which you want to apply the filter.

Infrared Film (9 Effects)

Complete Edition Select Edition

Simulates both Color and Black and White Infrared films. Use this filter to simulate different methods of capturing the infrared portion of the electromagnetic radiation spectrum, and the effects produced by films that can capture those wavelengths.

From the pull-down menu, select Color or Black and White infrared film types or different styles of both. Each option provides the following controls:

Lighten Highlights – Controls the luminosity of the highlights within the image.

Brightness – Controls the overall lightness of the image.

Contrast – Controls the overall contrast of the image.

Infrared Thermal Camera

Complete Edition Select Edition

Simulates the effect of night vision goggles or scientific heat-to-color cameras. Use this filter to create a stylistic abstraction of the original image.
**Type** – From the pull-down menu, select the simulated effect of either night vision goggles or a heat-to-color camera.

**Center Size** – Controls the size of a simulated, projected light source onto the image.

**Smear** – Controls the degree of the filter’s softening technique.

**Color** – Controls the relationship between the tonal values of the original image and the colors introduced by the filter.

**Place Center** – Positions the center of the image. This is useful if the subject is not in the center of the frame. Click this button and then place the center where desired.

**Ink (11 Effects)**

Simulates the stylistic effect of special photographic papers and toners.

From the pull-down menu, select a pre-defined color combination. Each color combination provides the following control:

**Strength** – Controls the degree to which you want to apply the filter.

**Low Key**

Simulates the look of low-key photography, characterized by uniformly dark tones and low contrast.

**Add Glow** – Controls the degree of glow around objects from the low key effect.

**Saturation** – Controls the overall vibrancy of colors by increasing or decreasing saturation throughout the image.

**Effect Strength** – Controls the degree to which you want to apply the filter.

**Midnight (5 Effects)**

Creates the illusion of a photograph taken at night with a dark, moody feeling. Use the Midnight filter to create a cinematic effect, softening details throughout the image with an intelligent soft-focus technique.

Use the provided pull-down menu to select from one of the pre-defined color combinations. The following controls are available for each color combination:

**Blur** – Controls the amount of soft focus added for a stylistic effect.

**Contrast** – Controls the overall contrast of the image.
Brightness – Controls the overall lightness of the image.

Color – Controls the relationship between the amount of color added by the filter and the amount of color to include from the original image.

Monday Morning (5 Effects)

Introduces a diffused, cool, and somewhat sleepy mood to an image. Use this filter to control contrast and saturation, add grain, and apply a soft focus effect.

From the pull-down menu, select a pre-defined color combination. Each color combination provides the following controls:

- **Grain** – Controls the amount of grain added to the image.
- **Brightness** – Controls the overall lightness of the image.
- **Smear** – Controls the degree of the filter’s softening technique.
- **Color** – Controls the relationship between the amount of color added by the filter and the amount of color to include from the original image.

Old Photo (12 Effects)

Transforms an image to resemble an old photograph, with styles to simulate various black-and-white and color processes.

From the pull-down menu, select a pre-defined old-fashioned photographic process. Each option provides the following controls:

- **Grain** – Controls the amount of grain added to the image.
- **Brightness** – Controls the overall lightness of the image.

Paper Toner (8 Effects)

Simulates the different types of toners typically used on black and white prints in darkrooms. Use this filter to automatically convert an image into a black and white version before adding the toner effect; however, for best results and more control, use the B/W Conversion filter first.

From the pull-down menu, select a pre-defined type of toner. Each option provides the following control:

- **Strength** – Controls the degree to which you want to apply the filter.
Pastel (3 Effects)

Lightens and softens an image for a smooth, stylistic effect, resulting in a subdued, desaturated image.

From the pull-down menu, select a pre-defined pastel. Each option provides the following controls:

**Diffusion** – Controls the amount of detail in the image. Slides to the left for stronger original image details, to the right for smoother image details.

**Saturation** – Controls the overall vibrancy of colors by increasing or decreasing saturation throughout the image.

**Contrast** – Controls the overall contrast of the image.

Photo Stylizer (18 Effects)

Photo Stylizer combines filters found in Color Efex Pro 2.0 – Varitone, Cool Ice, Cool Silver, Copper and Russet – in a single filter.

Use this filter to transform an otherwise plain or ordinary image to a more stylized and desirable one.

Use the provided pull-down menu to select from one of the Photo Stylizer filters. The following filters and controls are available:

**Varitone**
- **Style** – From the pull-down menu, select one of the effects of the Varitone filter.
- **Strength** – Controls the degree to which you want to apply the filter.

**Cool Ice**
- **Style** – From the pull-down menu, select one of the effects of the Cool Ice filter.
- **Brightness** – Controls the overall lightness of the image.

**Cool Silver**
- **Style** – From the pull-down menu, select one of the effects of the Cool Silver filter.
- **Strength** – Controls the degree to which you want to apply the filter.

**Copper**
- **Warmth** – Controls the degree of warmth (orange-red) to add to the image.
- **Strength** – Controls the degree to which you want to apply the filter.

**Russet**
- **Style** – From the pull-down menu, select one of the effects of the Russet filter.
- **Strength** – Controls the degree to which you want to apply the filter.
**Polarization**

Simulates the color contrasts of a conventional polarization filter. Use this filter to enhance blue skies and other similar colors, while increasing the contrast throughout the rest of the image.

**Rotate** – Simulates the effect of rotating a polarization filter in front of a lens and controls color contrasts.

**Strength** – Controls the degree to which you want to apply the filter.

---

**Polaroid Transfer**

Simulates the effect of using Polaroid color peel-apart films and transferring the nascent image to paper before it has fully developed. The result is a low-contrast, low-saturation version of the image, with subtle shifts to the colors throughout the image, reminiscent of this popular photographic technique.

**Border** – Adds a textured border around the image. When the slider is set to 0, the full image is displayed.

**Texture** – Controls the addition of paper texture to the image, emulating the use of textured paper.

---

**Pro Contrast**

Provides advanced control over the color and contrast of an image by taking advantage of the TrueLight™ color processing system available in every Color Efex Pro 3.0 filter. Use this filter to introduce higher levels of contrast and maintain more detail than with conventional methods of contrast enhancement.

**Correct Color Cast** – Controls the reduction of a color cast that the filter automatically identifies in the image.

**Correct Contrast** – Increases the contrast in the image according to the tonal distribution that the filter identifies by analyzing the image.
**Reflector Effects** (3 Effects)

Simulates traditional photographic reflectors to open up shadows and control light in the image.

From the pull-down menu, select Silver, Soft Gold, or Gold. Each option provides the following controls:

- **Light Intensity** – Controls the amount of light the reflector adds to the image.
- **Light Falloff** – Controls how abruptly the effect trails off.
- **Position** – Controls where the falloff begins.
- **Source Direction** – Specifies the point at which the Reflector effect begins.

**Remove Color Cast**

Removes color casts quickly and effectively within an image.

- **Strength** – Controls the degree to which you want to apply the filter.

**Color** – Specifies the color cast to remove from the image. Move the slider until the selected color matches the predominant color cast in the image.

**Saturation Stylizer** (7 Effects)

Saturation Stylization combines filters from Color Efex Pro 2.0 – Remove Brightness and Saturation to Brightness – in a single filter. Use this filter to create abstract versions of the original image, by altering and controlling saturation in the image.

From the provided pull-down menu, select one of the available Saturation Stylizer filters. The following filters and controls are provided:

- **Remove Brightness**
  Removes the relationship of lightness among pixels, such that all pixels contain uniform tonal values. The result is an image with lower levels of contrast yet with rich, saturated colors.

- **Style** – From the pull-down menu, select the color style to apply after the filter has removed the brightness values.

- **Saturation** – Controls saturation in the image after the filter has removed the brightness values.

- **Brightness** – Controls the overall lightness of the image.

**Saturation to Brightness**

Swaps the saturation value for the brightness value, converting bright colors to highly saturated ones and highly saturated objects to bright ones.
**Brightness** – Controls the overall lightness of the image.

**Saturation** – Controls the amount of color to include from the original image.

**Nudge Colors** – Shifts the colors from one direction to the other.

**Skylight Filter**

Combines the effects of both a conventional skylight filter and a conventional warming filter. Use this filter to remove offending blue casts and apply an intelligent warming function to colors.

**Strength** – Controls the degree to which you want to apply the filter.

**Solarization** (12 Effects)

Simulates the Sabatier (more often referred to as a Solarization) darkroom process. Use this filter to create a stylistic effect in which some tones and colors are reversed.

From the pull-down menu, select the type of solarization to add to the image. The effects are derived from simulating different paper emulsions and development processes. Each option provides you with the following controls:

**Saturation** – Controls saturation in the image before the filter has added the solarization effect. (At 0%, this creates the effect of Solarization: Black and White.)

**Elapsed Time** – Adjusts the simulated effect of more or less time in the developer before the filter has added the solarization effect.

**Sunshine**

Makes virtually any image appear as though it was shot on a bright, sunny day. Use this filter to add light, contrast, saturation and warmth for a natural, realistic effect.

**Saturation Correction** – Controls the intensity of colors in the image.

**Cool Color Reduction** – Controls the reduction of cool or blue colors in the image.

**Light** – From the pull-down menu, select one of four sunlight effects, from low-contrast, hazy light to high-contrast, direct light.

**Light Intensity** – Controls the amount of light the filter adds to the image. If the light-casting algorithm is off, this control does not affect the image.

**Radius** – Controls the amount of detail-smoothing or haze in the image.

**Prefilter** – From the pull-down menu, select one of eight color contrast prefilters, to bring out different colors in the image.

**Prefilter Strength** – Controls the degree to which you want to apply the prefilter.
Tonal Contrast

Allows powerful control over the contrast only of highlights, midtones or shadows, without affecting the rest of the image. Use this filter for highly targeted control of a particular portion of the tonal range of the image.

**Highlight Contrast** – Controls the degree of contrast added to only the highlights (brightest objects) of the image.

**Midtone Contrast** – Controls the degree of contrast added to only the midtones of the image.

**Shadow Contrast** – Controls the degree of contrast added to only the shadows of the image.

**Saturation** – Controls the overall vibrancy of colors by increasing or decreasing saturation throughout the image.

**Conventional High Pass Contrast** – When off, the Tonal Contrast filter will utilize a unique contrast method specially designed for this filter. In some situations, this unique contrast method can create uncover unwanted image details in the image. To prevent those unwanted details from being revealed, turn this checkbox on to switch from the unique contrast method to a conventional high pass based contrast method.

Vignette

Simulates the application of a vignette in a darkroom.

**Vignette Color** – Lets you select a vignette color to add to the image. To select a color for this control you may either use the eyedropper within the active image or click on the color patch using the color picker in your image editing application.

**Shape** – From the pull-down menu, select a circle, oval, smooth rectangle, or rough-edged rectangle shape to add to the image.

**Adapt Edges** – Controls the relationship between the shape of the vignette and the image details. The higher the value on the Adapt Edges slider, the more the vignette shape integrates with the image details.

**Transition** – Controls how abruptly the vignette blends into the original image details.

**Size** – Adjusts the area of the image covered by the vignette.

**Opacity** – Controls the overall strength of the filter.

**Place Center** – Positions the center of the image. This is useful if the subject is not in the center of the frame. Click this button and then place the center where desired.
**Vignette Blur** (4 Effects)

Defocuses detail around the center of the image, drawing the eye to the inside of the image.

From the pull-down menu, select a circle, oval or rectangle shape as the basis for the blur effect. Each option provides the following controls:

- **Blur** – From the pull-down menu, select the type of blur or soft focus to add to the image.

- **Transition** – Controls how abruptly the vignette blends into the original image details.

- **Size** – Adjusts the area of the image covered by the vignette.

- **Opacity** – Controls the overall strength of the filter.

- **Place Center** – Positions the center of the image. This is useful if the subject is not in the center of the frame. Select this button and then place the center where desired.

---

**White Neutralizer**

Removes color casts from light objects, such as white walls and brides’ dresses, in a subtle manner. Use this filter to clean up images and create bright, crisp whites, without affecting other colors in the image.

- **Color Cast** – Specifies the color cast to remove from the image. To select a color for this control you may either use the eyedropper within the active image or click on the color patch using the color picker in your image editing application.

- **Adjust Whole Image** – Removes the color selected in the Color Cast control from the entire image.

- **Neutralize Whites** – Removes the color selected in the Color Cast control from only the bright objects in the image.
Chapter 10: Contact and Support

United States

Contact Nik Software, Inc. by phone at (619) 725-3150

Monday - Friday from 8:30 AM - 5:00 PM (PST) or via email at service@niksoftware.com

Nik Software, Inc.
7588 Metropolitan Drive
San Diego, CA 92108, USA
Phone (619) 725-3150
Fax (619) 725-3151
infous@niksoftware.com

www.niksoftware.com

Germany

In Europe, contact Nik Software, GmbH at +49-40-47-11-35-0

Monday - Friday from 9:00 AM - 5:00 PM (CET) or via email at serviceeu@niksoftware.com.

Nik Software, GmbH
Hammerbrookstraße 93
D-20097 Hamburg, Germany

Phone +49-40-47-11-35-0
Fax +49-40-47-11-35-35

infoeu@niksoftware.com

www.niksoftware.com

For more information on Nik Software products go to

© 2007-2008 Nik Software, Inc.

Protected by one or more US Pats. 6,728,421; 6,865,300; 7,031,547; and other patents pending.

U Point and Dfine are registered trademarks of Nik Software, Inc. Nik, the Nik logo, Color Efex Pro, Viveza, and TrueLight are trademarks of Nik Software, Inc. All other trade names mentioned in this manual are trademarks or registered trademarks of their respective holders.